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12.2 NHT Modeling Overview

12.4 Procedure of Using FLUENT
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12.5 Introduction to ICEM and Meshing with  ICEM for 
structural grid
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FLUENT, CFX, COMSOL, STAR-CD, ABAQUS, PHOENICS, 

ADINA, NASTRAN…..

12. 1. Introduction to Numerical Heat Transfer Software 

Market share: Fluent>CFX> others

Accuracy: case-dependent

Technical documentation available:

Fluent>CFX> others
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Fluent is a general-purpose computational fluid dynamics
(CFD) program for modeling fluid flow, heat transfer, and
chemical reactions in complex geometries.

It offers a user-friendly interface that streamlines the CFD
process from pre- to post-processing within a single-
window workflow（流程化操作、操作简便）.

It provides complete mesh flexibility, including the ability to

solve flow problems using unstructured meshes(重要特点)

that can be generated about complex geometries.
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Graphics window
（图形窗口）

Menu bar
（菜单栏）

Standard and Graphics tool bar
（标准图形工具栏）

Navigation pane
(导航窗格)

Task page
（任务页面）

Console(命令行窗口)
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The Contents of the FLUENT Manuals
1). Getting Started Guide contains general information about
getting started with using FLUENT.(56 Pages)
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2). User’s Guide contains detailed information about using
FLUENT, including information about the user interface, reading
and writing files, defining boundary conditions, setting up physical
models, calculating a solution and analyzing results.(2498 Pages)
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3). Theory Guide contains reference information for how the
physical models are implemented in FLUENT.
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3). Workbench User's Guide contains information about getting
started with and using FLUENT within the Workbench
environment.(110 Pages)
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4). UDF Manual contains information about writing and using
user-defined functions (UDFs).(566 Pages)

Hooking:挂载
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5).Tutorial Guide contains a number of example problems with
detailed instructions, commentary, and post-processing of
results.(1146 Pages)
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6).Text Command List contains a brief description of each of the
commands in FLUENT’s text interface.(128 Pages)
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7). Fuel Cell Modules Manual contains information about the
background and the usage of two separate add-on fuel cell models
for FLUENT.(119 Pages)

Δ
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Advantage of commercial NHT Software: 

Advantage of Self-programming for NHT: 

Easy to use! 
However, it can not solve all the problems! In our research, for 
individual calculations, particularly complicated models, there 
are still a few computation issues for Fluent.

It is rather important for research!
We can understand the basic procedures and mechanisms in NHT. 
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CFD analysis has replaced most of experiments to design
industrial products. If the United States and European Union
implement the same restrictive measures, we have to go back to
do a lot of experiments.

Almost all the widely used CFD softwares are controlled by the
United States and European Union. It remind us that U.S.A still
leads in industrial software and many other industries.

After learning the basic steps of other software, we should
develop our domestic CFD software.

Δ
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12.1.2 ANSYS Fluent software 

Multiphase Flow, Fluid-Structure Interaction, Turbulence Modeling

Heat Transfer: Conduction/Convection/Radiation Heat Transfer

Combustions/Pollution Distribution

Fluid flow: 2D planar, 2D axisymmetric, 2D axisymmetric with
swirl (rotationally symmetric), and 3D flows.

Incompressible or compressible flows, including all speed regimes
(low subsonic, transonic, supersonic, and hypersonic flows)
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Fluent solvers are based on the finite volume method.

3) Partial differential equations are discretized into a 
system of algebraic equations.(Chapter 5: Discretized 
Schemes of Diffusion and Convection Equation)

Fluid region of pipe flow is
discretized into a finite set
of control volumes

1) Domain is discretized into a finite set of control volumes.(Chapter 2.Discretization 
of Computational Domain计算区域与控制方程的离散化)

2) General conservation equations for mass, momentum, energy, etc. are solved on 
this set of volumes. (Chapters 5. Discretized Schemes of Diffusion and Convection 
Equation；第5章：对流扩散方程的离散格式)

4) All algebraic equations are then solved numerically to
obtain the solution field.(Chapter 7 Solution Methods for
Algebraic Equations第7章：代数方程的求解方法)

12.1.3 How Does NHT Software Work?
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12.2. NHT Modeling Overview

• Transport Equations
– mass
– momentum
– energy

• Supporting Physical 
Models

Solver

Physical Models
 Turbulence
 Combustion
 Radiation
 Multiphase
 Phase Change
 Moving 

Zones
 Moving Mesh

 Mesh 
Generator

Material Properties
Boundary Conditions
 Initial Conditions

Solver Settings

Pre-Processing
 Modeler

Post-Processing

Equations solved on mesh
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12.2.1 NHT Analysis: Basic Steps
 Problem Identification and Pre-Processing

 Solver Execution

 Post-Processing

1.  Define our modeling goals.（控制方程及边界条件）

2.  Identify the domain we will model.
3.  Design and create the grid. (计算区域与控制方程的离散化，第1和2章)

4.  Set up the numerical model.(算法和格式选择，第5，6章)
5.  Compute and monitor the solution.(方程求解，第7章)

6.  Examine the results.
7.  Consider revisions to the model.
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1. Define Our Modeling Goals
1) What results are we looking for, and how will they be used?

• What are our modeling options?
• What physical models will need to be included in our analysis?
• What simplifying assumptions do we have to make?
• What simplifying assumptions can we make?
• Could we use user-defined functions (written in C)?

2) What degree of accuracy is required?

3) How quickly do we need the results?
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4) How will you isolate a piece of the complete physical system?

5) Where will the computational domain begin and end?

6) Can it be simplified or approximated as a 2D or axi-symmetric 

problem?

• Do we have boundary condition information?
• Can the boundary condition types accommodate that information?
• Can we extend the domain to a point where reasonable data exists?
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2.Identify the Domain We Will Model
1) How will we isolate a piece of the complete physical system?

Example: Cyclone 
Separator

2) Where will the computational domain begin and
end?

3) Can it be simplified or approximated as a 2D or
axisymmetric problem?

Gas

Riser

Cyclone

L-valve
Gas

 Are the boundary condition types appropriate?
 Do we have boundary condition information at 

these boundaries?
 Is the domain appropriate?
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3.Design and Create the Grid

2) What degree of grid resolution is required in each region of
the domain?Triangle

三角形
Quadrilateral

四边形

Tetrahedron
四面体

Pyramid
金字塔

Hexahedron
六面体

1) Can we use a quad/hex (四边形的/六面体的) grid or should we use a tri/tet (三角形/四
面体) grid or hybrid grid?

3) Do we have sufficient computer memory?

Is the resolution sufficient for the geometry?
Can we predict regions with high gradients?
Will we use adaption to add resolution?

How many cells are required?
How many models will be used?

How complex is the geometry and flow?

Prism/wedge
五面体
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Some basic grid
terminology
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Cell Control volume
Cell center Location where cell data is stored
Face Boundary of a cell (2D or 3D)
Edge Boundary of a face (3D)
Node Grid point
Cell thread Grouping of cells
Face thread Grouping of faces
Node thread Grouping of nodes
Domain A grouping of node, face, and cell threads

Mesh Terminology
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Fluent is an unstructured solver. It uses internal data structures to
assign an order to the cells, faces, and grid points in a mesh and to
maintain contact between adjacent cells.

Therefore, it does not require i, j, k indexing to locate neighboring cells.
This gives us the flexibility to use the best mesh topology for our problem,
as the solver does not force an overall structure or topology on the mesh.
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 Examples of Acceptable Mesh Topologies

Structured Quad Mesh for an 
Airfoil

Unstructured Quad 
Mesh

Multiblock Structured Quad Mesh

Parachute Modeled With Zero-
Thickness Wall

Unstructured Triangular 
Mesh for an Airfoil Hybrid Tri/Quad Mesh with 

Hanging Nodes
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 Choosing the Appropriate Mesh Type

Fluent can use meshes comprised of triangular or quadrilateral cells (or a
combination of the two) in 2D domain, and tetrahedral, hexahedral,
polyhedral, pyramid, or wedge cells (or a combination of these) in 3D
domain.

① Setup time

The choice of which mesh type to use will depend on the actual
application. When choosing mesh type, consider the following issues:

② Computational expense

③ Numerical diffusion(false diffusion)(Chapter 5.5, P.152)
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Many flow problems solved in engineering practice involve complex
geometries. The creation of structured or block-structured meshes
(consisting of quadrilateral or hexahedral elements) for such problems can
be extremely time-consuming.

Therefore, setup time for complex geometries is the major
motivation for using unstructured meshes employing triangular or
tetrahedral cells. However, if the geometry is relatively simple, there
may be no saving in setup time with either approach.

(1) Setup Time
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Other risks of using structured or block-structured meshes with
complicated geometries include the oversimplification of the
geometry, mesh quality issues, and a less efficient mesh
distribution(for example, fine resolution in areas of less
importance) that results in a high cell count.

(2) Computational Expense
When geometries are complex or the range of length scales of

the flow is large, a triangular/tetrahedral mesh can be created
with far fewer cells than the equivalent mesh consisting of
quadrilateral/hexahedral elements.
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Structured quadrilateral/hexahedral meshes will generally
force cells to be placed in regions where they are not needed.
Unstructured quadrilateral/hexahedral meshes offer many of the
advantages of triangular/tetrahedral meshes for moderately-
complex geometries.

A characteristic of quadrilateral/hexahedral elements that
might make them more economical in some situations is that
they permit a much larger aspect ratio than
triangular/tetrahedral cells.
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A large aspect ratio in a triangular/tetrahedral cell will
invariably affect the skewness of the cell, which is undesirable
as it may impede accuracy and convergence.

Therefore, if it is a relatively simple geometry in which the
flow conforms well to the shape of the geometry, such as a long
thin duct, use a mesh of high-aspect-ratio quadrilateral/
hexahedral cells. The mesh is likely to have far fewer cells than
if we use triangular/tetrahedral cells.
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The following practices are generally recommended:

② For moderately complex geometries, use unstructured
quadrilateral/hexahedral meshes.

① For simple geometries, use quadrilateral/hexahedral(四边形/六
面体) meshes.

③ For relatively complex geometries, use triangular/tetrahedral(三
角形和四面体) meshes with wedge elements in the boundary
layers.

④ For extremely complex geometries, use pure triangular/
tetrahedral meshes.



39/253

热流科学与工程
教育部重点实验室

Tri/Tet vs. Quad/Hex Meshes

1) For simple geometries, quad/hex
meshes can provide higher-quality
solutions with fewer cells than a
comparable tri/tet mesh.

2) For complex geometries, quad/hex
meshes show no numerical advantage,
and we can save meshing effort by using
a tri/tet mesh.
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Hybrid Mesh Example
 Valve port grid

Hybrid mesh for an engine valve port

tet mesh

hex mesh

wedge mesh

1) Specific regions can be meshed
with different cell types.

2) Both efficiency and accuracy are
enhanced relative to a hex or tet
mesh alone.

3) Tools for hybrid mesh generation
are available in ICEM.
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(3). Numerical diffusion(False Diffusion) (Chapter 5.5, P.152)

A dominant source of error in multidimensional situations is
false diffusion. Its effect on a flow calculation is similar as that of
increasing the real diffusion coefficient.

The following comments can be made about false diffusion:

① All practical numerical schemes for solving fluid flow contain
a finite amount of false diffusion. This is because false
diffusion arises from truncation errors (截断误差) that are a
consequence of representing the fluid flow equations in
discrete form.
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② The second-order upwind, QUICK and the MUSCL
discretization scheme used in Fluent can help reduce the
effects of false diffusion on the solution.（Chapter 5.6,
P162）

③ The amount of false diffusion is inversely related to the
resolution of the mesh. i.e. a coarser mesh will have more
false diffusion than a more refined mesh. Therefore, one
way of dealing with false diffusion is to refine the mesh.
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False diffusion
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If we use a quadrilateral/hexahedral mesh, this situation might
occur, but not for complex flows. It is only in a simple flow, such as
the flow through a long duct, in which we can rely on a
quadrilateral/hexahedral mesh to minimize false diffusion.

•False diffusion is minimized when the flow is aligned with the mesh.

In such situations, it is advantageous to use a
quadrilateral/hexahedral mesh, since we will be able to get a better
solution with fewer cells than if we were using a
triangular/tetrahedral mesh.
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The worst cells will have an orthogonal quality closer to 0 and
the best cells will have an orthogonal quality closer to 1.

The quality of the mesh plays a significant role in the accuracy and stability
of the numerical computation. Regardless of the type of mesh used in our
domain, checking the quality of our mesh is essential. One important indicator
of mesh quality that Fluent allows to check is a quantity referred to as the
orthogonal quality.

Mesh Requirements and Considerations
Mesh Quality- Orthogonal quality (正交质量)
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The minimum value of the two above equations for all of
the faces is defined as the orthogonal quality for the cell.

Area vector of 
a face

Area vector is a surface normal
vector that points outwards from
the domain and has a magnitude
equal to the area of the wall cell face
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Another important indicator of mesh quality is aspect ratio(长
宽比). The aspect ratio is a measure of the stretching of a cell.

It is computed as the ratio of the
maximum value to the minimum value of
any of the following distances: the normal
distances between the cell centroid and face
centroids (computed as a dot product of the
distance vector and the face normal), and
the distances between the cell centroid and
nodes.

Mesh Quality- Aspect ratio
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The higher of this ratio, the stretching of the cell is obvious. 
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 Mesh Element Distribution

Since it is discretely defining a continuous domain, the degree to which the
salient features of the flow (such as shear layers, separated regions, shock
waves, boundary layers, and mixing zones) are resolved depends on the
density and distribution of mesh elements.

In many cases, poor resolution in critical regions can dramatically affect
results. For example, the prediction of separation due to an adverse pressure
gradient depends heavily on the resolution of the boundary layer upstream of
the point of separation.
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Resolution of the boundary layer (i.e., mesh spacing near walls) also
plays a significant role in the accuracy of the computed wall shear stress
and heat transfer coefficient. In the near-wall region, different mesh
resolutions are required depending on the near-wall model being used.

In general, no flow passage should be represented by fewer than 5
cells. Most cases will require many more cells to adequately resolve the
flow passage. In regions of large gradients, as in shear layers or mixing
zones, the mesh should be fine enough to minimize the change in the flow
variables from cell to cell.
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Cell Quality
The quality of the cell (including its orthogonal quality(正交质量), aspect

ratio(最大长宽比), and skewness(偏斜度)) also has a significant impact on the
accuracy of the numerical solution.

Skewness is defined as the difference between the shape of the cell and the
shape of an equilateral cell of equivalent volume. Highly skewed cells can
decrease accuracy and destabilize the solution. A general rule is that the
maximum skewness for a triangular/tetrahedral mesh in most flows should be
kept below 0.95, with an average value that is significantly lower. A maximum
value above 0.95 may lead to convergence difficulties and may require
changing the solver controls, such as reducing under-relaxation factors and/or
switching to the pressure-based coupled solver.
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Value of Skewness Cell Quality

1 degenerate

0.9 — <1 bad (sliver)

0.75 — 0.9 poor

0.5 — 0.75 fair

0.25 — 0.5 good

>0 — 0.25 excellent

0 equilateral

Equilateral-Volume-Based Skewness

The difference of cell and
equilateral cell should be
as small as possible!
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Mesh Quality（2D）:
Orthogonal Quality ranges from 0 to 1, where values close to 0 correspond 

to low quality.
Minimum Orthogonal Quality = 6.07960e-01
Maximum Aspect Ratio = 5.42664e+00

Mesh Quality（3D）:
Minimum Orthogonal Quality =  5.09565e-01
(Orthogonal Quality ranges from 0 to 1, where values close to 0 correspond to 
low quality.)
Maximum Ortho Skew =  4.90435e-01
(Ortho Skew ranges from 0 to 1, where values close to 1 correspond to low 
quality.)
Maximum Aspect Ratio =  5.51406e+01
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 Smoothness

Rapid changes in cell volume between adjacent cells translate
into larger truncation errors.
*Truncation error is the difference between the partial derivatives in the
governing equations and their discrete approximations.(Chapter 2.2, P32,截断

误差)

Fluent provides the capability to improve the smoothness by
refining the mesh based on the change in cell volume or the
gradient of cell volume.
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The effect of resolution, smoothness, and cell shape on the
accuracy and stability of the solution process is dependent on the
flow field being simulated. For example, very skewed cells can be
tolerated in benign(平缓的 ) flow regions, but can be very
damaging in regions with strong flow gradients.

 Flow-Field Dependency

Since the locations of strong flow gradients generally cannot
be determined before the simulation, we should strive to achieve
a high-quality mesh over the entire flow domain.
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4. Set Up the Numerical Model
 For a given problem, we will need to:

Solving initially in 2D domain
will provide valuable experience
with the models and solver
settings for our problem in a
short amount of time.

① Select appropriate physical models.
 Turbulence, combustion, multiphase, etc.

② Define material properties.
 Fluid/Solid/Mixture

③ Prescribe operating conditions.
④ Prescribe boundary conditions at all 

boundary zones.

⑤ Provide an initial solution.

⑥ Set up solver controls.

⑦ Set up convergence monitors.
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5. Compute the Solution
①The discretized conservation equations are solved iteratively.

② Convergence is reached when:

③ The accuracy of a converged solution is dependent upon:

A number of iterations are usually required to reach a converged solution.

Changes in solution variables from one iteration to the next are negligible.
Residuals provide a mechanism to help monitor this trend.
Overall property conservation is achieved.

Appropriateness and accuracy of physical models.
Grid resolution and independence
Problem setup
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6. Examine the Results
 Examine the results to review solution and extract useful data.

Examine results to
ensure property
conservation and
correct physical
behavior. High
residuals may be
attributable to only
a few cells of poor
quality.

2) Numerical Reporting Tools can be used to calculate 
quantitative results:

1) Visualization Tools can be used to answer such questions as:

• What is the overall flow pattern?
• Is there separation?
• Where do shear layers form?
• Are key flow features being resolved?

• Forces and Moments
• Average heat transfer coefficients
• Surface and Volume integrated quantities
• Flux Balances
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7. Consider Revisions to the Model
1) Are physical models appropriate?

2) Are boundary conditions correct?

3) Is grid adequate?

Is flow turbulent?            Is flow unsteady?
Are there compressibility effects?      Are there 3D effects?

Is the computational domain large enough?
Are boundary conditions appropriate?
Are boundary values reasonable?

Can grid be adapted to improve results?
Does solution change significantly with adaption, or is the solution grid 
independent?
Does boundary resolution need to be improved?
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Example 1: Flow over a cylinder(Kármán vortex street )

Vin1=0.01m/s

Vin

Vin
1200

40
0

R=50

12.3.Simple Examples to Using FLUENT
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Example 2: 2D Pipe Junction

Tin1=300K Vin1=1m/s Vin1=5m/sTin2=360K

40
0

Vi
n

Vin1

R200

R400

12
00

1200

30
0100

Vin2
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Example 3: Natural convection in a slot

Tleft=320K, Tright=300K

An example from text book(P161)
《数值传热学》第161页例题

Tleft Tright

10
00

100
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12.4.Procedures of Using FLUENT

Fluent launcher interface(2018vs.2023)
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FLUENT can readily be run across many processors in parallel. This will
greatly speed up the simulation time.

 Parallel Processing(并行处理)

1) It is common for modern computers to have several processors, or ‘cores’ per
processor. Each one of these can be a“node(节点)” for the FLUENT
simulation.

2)The mesh is automatically partitioned, and different blocks of the mesh are
assigned to the different compute nodes. The number of partitions is equal to or
less than the number of processors (or cores) available on our computer.

3)Alternatively a distributed parallel cluster(集群) can be set up, and the
simulation can run across many machines simultaneously.
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Generally, as the number of compute nodes
increases, turnaround time( 周 转 时 间 ) for
solutions will decrease. However, beyond a
certain point, the ratio of network
communication to computation increases,
leading to reduced parallel efficiency, so optimal
system sizing is important for simulations.

Each compute node is virtually connected to every other
compute node, and relies on inter-process
communication to perform such functions as sending
and receiving arrays, and performing global operations
(such as summations over all cells).
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• The FLUENT Graphical User Interface (GUI,图形界面) is arranged such that
the tasks are generally arranged from top to bottom in the project setup tree.
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(ANSYS Fluent 2023)
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 Text User Interface
Most GUI commands have a corresponding TUI command.
1) Press the Enter key to display the command set at the current level.
2) Some advanced commands are only available through the TUI.

TUI
Window
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The TUI offers many valuable benefits:

2) FLUENT can be run in batch mode(批处理模式), with TUI journal scripts
set to automate the loading/modification/solver execution and post processing.

1) Journal files can be constructed to automate repetitive tasks(自动化重复任

务). A journal file is a text file which contains TUI commands which FLUENT
will execute sequentially(按顺序执行).
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(2)To generate a listing of the submenus and commands in the current menu,
simply press Enter.

><Enter>
adapt/file/report/define/mesh/solve/display/parallel/surface/exit/plot/

(1).The menu system structure is similar to the directory tree structure of Linux
operating systems. When we first start ANSYS FLUENT, we are in the “root”
menu.

(3)By convention, submenu names end with a “/” to differentiate them from
menu commands. To execute a command, just type its name (or an
abbreviation). Similarly, to move down into a submenu, enter its name or an
abbreviation. When we move into the submenu, the prompt will change to reflect
the current menu name.
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Sample Journal File

; Read case file
rc example.cas.gz
; Initialize the solution
/solve/initialize/initialize-flow
; Calculate 50 iterations
it 50
; Write data file
wd example50.dat.gz
; Calculate another 50 iterations
it 50
; Write another data file
wd example100.dat.gz
; Exit FLUENT
exit

• Examples of abbreviations of the commands:
– rcd： Reads case and data files
– wcd：Writes case and data files
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Selecting the basic items in the tree opens the relevant inputs
in the center pane.

① General

② Models

③ Materials

④ Boundary Conditions

⑤ Solution

⑥ Initialization and Calculation

⑦ Results

⑧ Post-processing

• FLUENT 2023 GUI Navigation
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• 1). Setup：前处理设置

• Materials：设置固体、流体物性参数

• Cell Zone Conditions：设置计算域属性

• Boundary Conditions：设置边界条件

• Dynamic Mesh：设置动网格

• Reference Values：设置参考值

• General：一般设置。如设置时间项(瞬态或稳态)、

求解器类型(压力基或密度基)等

• Models：设置物理模型。如湍流模型、多相流模型等
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•2). Solution：求解器设置

• Solution Controls：求解控制参数设置，如亚松弛因子设置

• Monitors：监视器设置

• Report Definitions：定义计算过程中的输出报告

• Report Files：列出定义的报告文件

• Report Plots：定义报告的输出形式

• Solution Initialization：初始化

• Calculation Activities：定义求解中的参数，如自动保存

、动画输出等

• Run Calculation：开始计算

• Solution Methods：求解算法设置，如算法、离散方法选择
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•3). Result：计算后处理

• Graphics：显示出各种量化图，如云图、矢量图、

流线图等

• Animations：显示动画

• Plots：显示各种线图

• Reports：显示报告

•4). Parameters & Customizations：参数化及自定义列表
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1. General setting
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Mesh files can be created with the mesh generators (ICEM, Fluent meshing
and TGrid), or by several third-party CAD packages. The mesh file contains
the coordinates of all the nodes, connectivity information that tells how the
nodes are connected to one another to form faces and cells, and the zone types
and numbers of all the faces.

The mesh file does not contain any information on boundary conditions or flow 
parameters.

File Read           Mesh...



79/253

热流科学与工程
教育部重点实验室

Mesh Check Report

① The mesh check report begins by listing the domain extents. The domain
extents include the minimum and maximum x, y, and z coordinates in meters.

② It also display warnings based on the results of the checks previously
described.
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③ Then the volume statistics are provided, including the minimum,
maximum, and total cell volume in m3. A negative value for the
minimum volume indicates that one or more cells have improper
connectivity. Cells with a negative volume(负体积) can often be
identified using the Iso-Value Adaption dialog box to mark them for
adaption and view them in the graphics window.

④ Next, the mesh report lists the face area statistics, including the
minimum and maximum areas in m2. A value of 0 for the minimum
face area indicates that one or more cells have degenerated. As with
negative volume cells, such faces must be eliminated. It is also
recommended to correct cells that have non-zero face areas, if the
values are very small.
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 Scaling the Mesh and Selecting Units

• When FLUENT reads a mesh file(.msh), all dimensions are assumed to be in 
units of meters.
① If our model was not built in meters, then it must be scaled.
② Always verify that the domain extents are correct.



82/253

热流科学与工程
教育部重点实验室

Any “mixed” units system can be used if desired.
① By default, FLUENT uses the  international system of units (SI).
② Any units can be specified in the Set Units panel, accessed from the top menu.
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Reading and Writing Case and Data Files

Information related to the ANSYS FLUENT simulation is stored in both the case file and 
the data file.

Case files contain the mesh, boundary and cell zone conditions, and solution
parameters for a problem. It also contains the information about the user
interface and graphics environment.

File          Read/Write           case/data...

File          Read/Write            case&data...

We can read a case file and a data file together:

Data files contain the values of the specified flow field quantities in each mesh
element and the convergence history (residuals) for that flow field.
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2. Setup the Models
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Turbulence Models Available in FLUENT(Chapter 9)
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It should be noted that no single turbulence model is universally accepted as
being superior for all classes of problems. The choice of turbulence model will
depend on considerations such as the physics of the flow, the established
practice for a specific class of problem, the level of accuracy required, the
available computational resources, and the amount of time available for the
simulation. To make the most appropriate choice of model for our application,
we need to understand the capabilities and limitations of the various options.

Compared to laminar flows, simulations of turbulent flows are more
challenging in many ways. Since the equations for mean quantities and the
turbulent quantities are strongly coupled in a highly non-linear fashion, it takes
more computational effort to obtain a converged turbulent solution than to
obtain a converged laminar solution.
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RANS based
models

Chapter 9

One Equation Model
Spalart-Allmaras

Two Equation Model
Standard k–ε

RNG k–ε
Realizable k–ε
Standard k–ω

SST k–ω
Two More Equation Models

Reynolds Stress Model
k–kl–ω Transition Model

SST Transition Model

Detached Eddy Simulation
Large Eddy Simulation

Increase in
Computational

Cost
Per Iteration
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Modeling Heat Transfer

Physical models involving conduction and/or convection only are
the simplest. While buoyancy-driven flow or natural convection, and
flow involving radiation are more complex. Depending on our
problem, ANSYS FLUENT will solve a variation of the energy
equation that takes into account the heat transfer methods we have
specified.

When the ANSYS FLUENT model includes heat transfer we will
need to activate the relevant physical models, supply thermal
boundary conditions, and input material properties (which may vary
with temperature) that govern heat transfer.
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To activate the calculation of heat transfer, enable the Energy Equation 
option in the Energy dialog box

Models          Energy           Edit...
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At flow inlets and exits we can set the temperature of fluid. 

When we are solving the energy equation, we need to define thermal boundary
conditions at wall boundaries. Five types of thermal conditions are available:

The default thermal boundary condition at inlets is a specified temperature
of 300 K; At walls the default condition is zero heat flux (adiabatic).

• Fixed heat flux
• Fixed temperature
• Convective heat transfer
• External radiation heat transfer
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1）Material properties need to be defined for all fluids and solids to be
simulated.
2）The parameters depend on the models selected for the simulation.
3）Many common materials are already defined in the ‘FLUENT Database’
and can easily be copied to the model.

Note that these values may be either:
① Constants
② Functions of temperature
③ Other built in functions following common relationships
④ Defined by the user in a UDF.

3. Material Properties
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① Density and/or molecular weights
② Viscosity
③ Heat capacity
④ Thermal conductivity
⑤ User-defined scalar diffusivity
⑥ Mass diffusion coefficients
⑦ Standard state enthalpies
⑧ Kinetic theory parameters

These properties may include:
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4.Cell Zone Conditions
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Operating Conditions(操作/运行工况)

① The Operating Pressure with a Reference Pressure Location sets the
reference value that is used in computing gauge pressures.

② The Operating Temperature sets the reference temperature (used when
computing buoyancy forces).

• Specified Operating Density sets the reference value for flows

with widely varying density.
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 Defining Cell Zones and Boundary Conditions
To properly define any NHT problem, we must define:

1）Cell zones
① These relate to the middle of the grid cells
② Typically this always involves setting up which material (fluid) is in that cell
③ Other values（heat sources, etc.)

2）Boundary conditions
①Where fluid enters or leaves the domain, the conditions must be set 
(velocity/pressure/temperature)
②Other boundaries also need declaring, like walls (smooth/rough, heat 
transfer?)
③There may also be symmetry, periodic or axis boundaries.

3）The data required at a boundary depends upon the boundary condition type   
and the physical models employed.
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 Cell Zones – Fluid

① A fluid cell zone is a group of cells for which all active equations 
are solved.

② The material in the cell zone must be declared.

• Optional inputs

① Moving zones

② Porous region

③ Source terms

④ Fixed Values
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Cell Zones - Porous Media

• Some fluid regions are obviously porous and impossible to
resolve exactly in a mesh:

– Packed beds，metal foam

The porous media model incorporates an empirically determined flow resistance
in a region of our model defined as “porous”. In essence, the porous media model
adds a momentum sink in the governing momentum equations.
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 Cell Zones – Solid

1) A solid zone is a group of cells for which only the energy equation is solved.

2) Only required input is the material name (defined in the Materials panel).

3) Optional inputs allow us to set volumetric heat generation rate(heat
source).

4) Need to specify rotation axis if rotationally periodic boundaries adjacent to 
solid zone.

5) Can define motion for a solid zone
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③ The data required at a boundary depends upon the boundary
condition type and the physical models employed.

④ Be aware of the information that is required of the boundary
condition, and locate the boundaries where the information on
the flow variables are known or can be reasonably
approximated
• Poorly defined boundary conditions can have a significant

impact on the solution
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5. Boundary Conditions
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It also allows for 
direct editing of 
boundary conditions 
on the geometries
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Defining Boundary Conditions
① To define a problem that results in a unique solution, we must specify

information on the dependent (flow) variables at the domain
boundaries
• Specifying fluxes of mass, momentum, energy, etc. into domain.

② Defining boundary conditions involves:
• Identifying the location of the boundaries (e.g. Inlets, walls,

symmetry)
• Supplying information at the boundaries
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• General guidelines:

21

1). If possible, select boundary location and shape such that flow either goes in 
or out.

It will typically observe better convergence.

2). Should not observe large gradients in direction normal to boundary.
Indicates incorrect set-up.

3). Minimize grid skewness near the boundary.
Otherwise it would introduce error early in calculation.
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Boundary Conditions - Available Types

1）General
• Pressure Inlet              • Pressure Outlet

2）Incompressible 
• Velocity Inlet               • Outflow 

4）Other
• Wall       • Symmetry       • Axis       • Periodic

3）Compressible
• Mass Flow Inlet          • Pressure Far Field

External Boundaries
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• Internal Boundaries
– Fan
– Interior
– Radiator
– Wall

Cell (Continuum) zones
– Fluid
– Solid
– Porous media
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Boundary Conditions – Changing the Types

• Zones and zone types are initially defined in the pre-

processing phase(eg.ICEM).

• To change the boundary condition type for a zone:
① Choose the zone name in the Zone list.
② Select the type we wish to change it to in the Type pull-

down list.
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 Boundary Conditions - Velocity Inlet

1) Velocity Specification Method
– Magnitude, Normal to Boundary
– Magnitude and Direction

2) Applies a uniform velocity profile at the boundary, unless UDF or profile is 
used.

3) Velocity inlets are intended for use in incompressible flows and are not 
recommended for compressible flows.

4) Velocity Magnitude input can be negative, implying that is the velocity in 
the exit.
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 Boundary Conditions - Pressure Inlet

1) Pressure inlets are suitable for both compressible and incompressible flows.
– FLUENT calculates static pressure and velocity at inlet (Dynamic pressure)    

2) Required inputs

① Gauge Total Pressure

② Supersonic/Initial Gauge Pressure

③ Inlet flow direction

④ Turbulence quantities( if applicable)

⑤ Total temperature (heat transfer or compressible)
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Boundary Conditions - Mass Flow Inlet

1) Mass flow inlets are intended for compressible flows; however,
they can be used for incompressible flows.

① Total pressure adjusts to accommodate mass flow inputs.
② More difficult to converge than pressure inlet.

2) Required information
① Mass Flow Rate or Mass Flux
② Supersonic/Initial Gauge Pressure
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Boundary Conditions - Pressure Outlet

1) Suitable for compressible and incompressible flows.

2) Required information
① Gauge Pressure (static)–static pressure of the environment into which
the flow exits.
② Backflow quantities–Used as inlet conditions when backflow occurs
(outlet acts like an inlet).
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 Boundary Conditions - Periodic Boundaries
1) Used to reduce the overall mesh size.

2) Flow field and geometry must contain either rotational or translational 
periodicity.

• ΔP=0 across periodic planes.
• Axis of rotation must be defined in fluid zone.

ΔP can be finite across periodic planes.
5) Rotationally periodic planes

Models fully developed conditions.
Specify either mean ΔP per period or net mass flow rate.

3) Rotational periodicity

4) Translational periodicity
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Boundary Conditions - Internal Faces
① Defined on the cell faces only:

– Thickness of these internal faces is zero
– These internal faces provide means of introducing step changes in flow 

properties.

② Used to implement various physical models including:
– Fans
– Radiators

③ Preferable over porous media for its better convergence behavior.
– Interior walls

④ The "interior'' type of internal face zone does not require any input.
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Boundary Conditions - Outflow
① No pressure or velocity information is required.

– Data at exit plane is extrapolated from interior.
– Mass balance correction is applied at boundary.

② Flow exiting outflow boundary exhibits zero normal diffusive flux for all
flow variables.

– Appropriate where the exit flow is fully developed.

③ The outflow boundary is intended for use with incompressible flows.
– Cannot be used with a pressure inlet boundary (must use velocity-inlet).
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④ Cannot be used for unsteady flows with variable density.

⑤ Convergence rate is poor when backflow occurs during iterations.
Cannot be used if backflow is expected in the final solution.
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Fin and tube heat exchanger simulation
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 Wall Boundary Conditions
• Five thermal conditions

① Heat Flux
② Temperature
③ Convection–simulates an external convection environment which is not 

modeled (user-prescribed heat transfer coefficient).
④ Radiation – simulates an external radiation environment which is not 

modeled (user-prescribed external emissivity and radiation temperature).
⑤ Mixed– Combination of Convection and Radiation boundary conditions.
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Momentum conditions
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6. Solution Methods SIMPLE：Semi-
Implicit Method for 
Pressure Linked 
Equations
Chapters 5. Discretized 
Schemes of Diffusion and 
Convection Equation；第5
章：对流扩散方程的离散

格式

Chapter 6：Primitive 
Variable Methods for 
Elliptic Flow and Heat 
Transfer第6章：求解椭圆

型流动与换热问题的原始

变量法
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Solution Procedure Overview
① Select the solution parameters

– Choosing the Solver
– Discretization Schemes

② Initialization

③ Check the convergence behavior
• Monitoring Convergence Stability

• Setting Under-relaxation factor
• Setting Courant number

• Accelerating Convergence

④ Evaluation the accuracy of computation result
• Grid Independence
• Adaption

Rather important for simulation result
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Modify solution 
parameters or gridNo

Yes

No

Set the solution parameters

Initialize the solution

Enable the solution monitors of interest

Calculate a solution

Check for convergence

Check for accuracy

Stop

Yes
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 When we select Explicit from the Formulation
drop-down list, in the Solution Methods task
page, ANSYS FLUENT will automatically set
the Courant Number to 1;

 When we select Implicit from the Formulation
drop-down list, the Courant Number will be
changed to 5 automatically.

The Solution Controls for Density-Based Explicit
Formulation
Courant number is a measure of how fast infor
mation traverses (u) a computational grid cell
(∆x) in a given time-step (∆t).
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Solver Settings
• By modifying the solver settings we can improve both:

① a. The choice of solver
② b. Discretization schemes
③ c. Checking convergence
④ d. Assessing accuracy

① The convergence rate of the simulation. (Chapter 6 求解椭圆形流动)

② The accuracy of the computed result.(Chapter 5 对流-扩散方程的离散

格式)

To Consider:
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① There are two kinds of solvers available in FLUENT:
Available Solvers

– Pressure based
– Density based

② The pressure-based solvers take momentum and pressure (or pressure
correction) as the primary variables(such as SIMPLE Algorithm)

③ Two algorithms are available with the pressure-based solvers:

 Segregated solver– Solves for pressure correction and momentum
sequentially.(SIMPLE, SIMPLC, PISO)

 Coupled Solver (PBCS) – Solves pressure and momentum
simultaneously(COUPLED).
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④ Density-Based Coupled Solver
– Equations for continuity, momentum, energy and species (if required) 

are solved in vector form.
– Pressure is obtained through an equation of state.
– Additional scalar equations are solved in a segregated fashion.

• The Density-Based Coupled Solver can be run either explicit or implicit.



135/253

热流科学与工程
教育部重点实验室



136/253

热流科学与工程
教育部重点实验室

Choosing a Solver

① The pressure-based solver(PBS) is applicable for a wide range of flow
regimes from low speed incompressible flow to high-speed compressible
flow.
 Requires less memory (storage).
 Allows flexibility in the solution procedure.

② The pressure-based coupled solver(PBCS) is applicable for most single 
phase flows, and yields superior performance to the standard pressure-
based solver.
Requires 1.5–2 times more memory than the segregated solver.
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③ The density-based coupled solver (DBCS) is applicable when there is a
strong coupling, or interdependence, between density, energy,
momentum, and/or species.

• The implicit option is generally preferred over explicit since it has a very
strict limit on time step size

• The explicit approach is used for cases where the characteristic time scale
of the flow is on the same order as the acoustic time scale. (e.g.
propagation of high-Ma shock waves).

Note: the pressure-based solvers are implicit

Examples: High speed compressible flow with combustion, hypersonic flows, 
shock interactions.
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 Interpolation schemes for convection term(Chapter 5:离散格式):

② Power Law – More accurate than first-order for flows when Recell <5 (typ.
low Re flows)

③ Second-Order Upwind –2nd order accuracy, essential with tri/tet mesh or
when flow is not aligned with grid; convergence may be slower.

⑤ Quadratic Upwind Interpolation (QUICK)–Applies to quad/hex and hybrid
meshes, useful for rotating/swirling flows, 3rd-order accurate on uniform
mesh.

① First-Order Upwind–Easiest to converge, only first-order accuracy.

④ Monotone Upstream-Centered Schemes for Conservation Laws (MUSCL) –
Locally 3rd order convection discretization scheme for unstructured meshes;
more accurate in predicting secondary flows, vortices, forces, etc.
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• Higher order schemes will be more accurate. They will also be less stable
and will increase computational time.
• It is recommended to always start calculations with first order upwind and
after 100 iterations or so to switch over to second order upwind. This
provides a good combination of stability and accuracy.

• The central differencing scheme should only be used for transient
calculations involving the large eddy simulation (LES) turbulence models in
combination with grids that are fine enough that the Peclet number is always
less than one.

• It is recommended to only use the power law or QUICK schemes if it is
known that those are somehow especially suitable for the particular problem
being studied.
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① Gradients of solution variables are required in order to evaluate diffusive 
fluxes, velocity derivatives, and for higher-order discretization schemes.

Interpolation Methods (Gradients)(插值方法)

② The gradients of solution variables at cell centers can be determined
using three approaches:

• Green-Gauss Cell-Based– Least computationally intensive. Solution may
have false diffusion.
• Green-Gauss Node-Based–More accurate/computationally intensive;
minimizes false diffusion; recommended for unstructured meshes.
• Least-Squares Cell-Based–Default method; has the same accuracy and
properties as Node-based Gradients and is less computationally intensive.
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Interpolation Methods for Pressure
Interpolation schemes for calculating cell-face pressures when using the pressure-

based solver in FLUENT are available as follows:
① Standard: The default scheme; reduced accuracy for flows exhibiting large

surface-normal pressure gradients near boundaries

② PRESTO!: Use for highly swirling flows, flows involving steep pressure
gradients, or in strongly curved domains

④ Second-Order: Use for compressible flows; not to be used with porous
media, jump, fans, etc. or VOF/Mixture multiphase models

③ Linear: Use when other options result in convergence difficulties or
unphysical behavior

⑤ Body Force Weighted: Use when body forces are large, e.g., high Ra natural
convection or highly swirling flows.
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Pressure-Velocity Coupling
Pressure-velocity coupling refers to the numerical algorithm which uses a
combination of continuity and momentum equations to derive an equation for
pressure (or pressure correction) when using the pressure-based solver.

Five algorithms are available in FLUENT.
① Semi-Implicit Method for Pressure-Linked Equations (SIMPLE)
The default scheme, robust 
② SIMPLE-Consistent (SIMPLEC)

Allows faster convergence for simple problems (e.g., laminar flows with no
physical models employed).

③ Pressure-Implicit with Splitting of Operators (PISO)
Useful for unsteady flow problems or for meshes containing cells with higher 

than average skewness.
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Enabling the Transient Solver(非稳态问题)
• To enable the transient solver, select the Transient button on the General 
problem setup form:
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① Before performing iterations, we will need to set some additional controls.
 Solver settings
Animations
 Data export/Autosave options

② Selecting the Transient Time Step Size

Time step size, Δt, is set in the Run Calculation form.
• Δt must be small enough to resolve time-dependent features; make sure
convergence is reached within the number of Max Iterations per Time Step
• The order or magnitude of an appropriate time step size can be
estimated as:



147/253

热流科学与工程
教育部重点实验室

Time step size estimate can also be chosen so that the transient
characteristics of the flow can be resolved (e.g. flow within a
known period of fluctuations)

① A good way to judge the choice of Δt is to observe the number of
iterations. FLUENT needs to converge at each time step. The ideal number
of iterations per time step is 5–10. If FLUENT needs substantially more, the
time step is too large. If FLUENT needs only a few iterations per time step,
it should be increased.
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③ To iterate without advancing in time, specify zero time
steps. This will instruct the solver to converge the current
time step only.

② It is often wise to choose a conservatively small for the first
5–10 time steps. Then gradually increased it as the
calculation proceeds.

④ The PISO scheme may aid in accelerating convergence for
many transient flows form.
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Transient Flow Modeling 
Options

• Adaptive Time Stepping   

Automatically adjusts
time-step size based on
local truncation error
analysis
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This approach is very useful in creating high-quality animations 
of CFD results.

Creating Animations

 A command is defined which generates an animation frame (contour 
plot, vector plot, etc.) and then writes that frame to a hard copy file.

 Third-party software can then be used to link the hard copy files into 
an animation file(AVI, MPG, GIF, etc.)
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 Performing Iterations

① The most common time advancement scheme is the iterative scheme.
• The solver converges the current time step and then advances time.
• Time is advanced when Max Iterations/Time Step is reached or
convergence criteria are satisfied.
• Time steps are converged sequentially until the Number of Time Steps
is reached.

② Solution initialization defines the initial condition and it must be realistic.
Sets both the initial mass of fluid in the domain and the initial state of the  
flow field.
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No
Iterations

Yes

Overview of the 
Iterative Time 
Advancement Solution 
Method for the 
Segregate Solver

T=t+nΔt

Solve Momentum Equations

Solve Pressure Corrections

Correct Velocity Pressure Flux

Solve other variables(T, k, ε, etc.)

Converged?

Next Time Step
n=n+1
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Convergence Behavior
① Residual plots for transient simulations are not always indicative of a

converged solution.

② We should select the time step size such that the residuals reduce by
around three orders of magnitude within one time step.

This will ensure accurate resolution of transient behavior.
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 Tips for Success in Transient Flow Modeling
① Use PISO scheme for Pressure-Velocity Coupling-this scheme provides faster

convergence for transient flows than the standard SIMPLE approach.

② Select the time step size so that the solution converges three orders of
magnitude for each time step(convergence behavior is also problem-specific).

③ Select the number of iterations per time step to be around 20 – it is better to 
reduce the time step size than to do too many iterations per time step.

④ Remember that accurate initial conditions are just as important as boundary
conditions for transient problems-initial condition should always be physically
realistic!

⑤ Configure any animations we wish to see before running the calculations.
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7.Solution Initialization
1)The solver works in an iterative 
manner.

2)Therefore, before the very first 
iteration, a value must exist for 
every quantity in every grid cell.

3)Setting this value is called 
‘Initialization’.

4) The more realistic the value,
the better (quicker)convergence
will be.
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 Starting from a Previous Solution
• Convergence rates are dependent on how good the starting point is.

• Then use the ‘Read and Interpolate’ option on the new model.

• Therefore if we already have a similar result from another simulation, we can
save time by interpolating that result into the new simulation.
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8.Run Calculation
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 Case Check

①Case Check is a utility in FLUENT
which searches for common setup
errors and inconsistencies.

③Contain recommendations which
the user can optionally apply or
ignore.

② It provides guidance in selecting
case parameters and models.
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Convergence

• The solver should be given sufficient iterations so that the 
problem is converged.
• At convergence, the following should be satisfied:

① The solution no longer changes with subsequent iterations.

② Overall mass, momentum, energy, and scalar balances are
achieved.

③ All equations (momentum, energy, etc.) are obeyed in all
cells to a specified tolerance.
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9. Monitoring 
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• Monitoring convergence using residual history:

① Generally, a decrease in residuals by three orders of magnitude
indicates at least qualitative convergence. At this point, the major
flow features should be established.

② Scaled energy residual should decrease to 10-6 (for the Pressure-
based solver).

③ Scaled species residual may need to decrease to 10-5 to achieve
species balance.
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Convergence Monitors – Residuals

• Residual plots show when the residual values have reached the specified tolerance.
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Convergence Monitors – Forces and Surfaces
If there is a particular value we are interested in (lift coefficient, average

surface temperature etc.), it is useful to plot how that value is converging.
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Checking Overall Flux Conservation
• Another important metric to assess whether the model is converged is to check
the overall heat and mass balance.
• The net flux imbalance (shown in the GUI as Net Results) should be less than
1% of the smallest flux through the domain boundary.
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 Tightening the Convergence Tolerance

• If solution monitors indicate that the solution is converged, but the
solution is still changing or has a large mass/heat imbalance, this
clearly indicates the solution is not yet converged.

• In this case, we need to:
– Reduce values of Convergence Criterion or disable Check 
Convergence in the Residual Monitors panel.
– Continue iterations until the solution converges.
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 Convergence Difficulties

① Sometimes running for further iterations is not the answer:
– Either the solution is diverging
– Or the residuals are ‘stuck（卡住）’ with a large imbalance still remaining.

② Troubleshooting
Continuity equation convergence trouble affects convergence of all equations.
a. Compute an initial solution using a first-order discretization scheme.
b. Alter the under-relaxation or Courant numbers.
c .Check the mesh quality. It can only take one very skewed grid cell to prevent 

the entire solution converging.
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 Modifying Under-Relaxation Factors
• Under-relaxation factor, α, is included to stabilize the iterative process for the
pressure-based solver.
• Use default under-relaxation factors to start a calculation. When the solution
is converged but the pressure residual is still relatively high, the factors for
pressure and momentum can be lowered to further refine the solution.

• The recommendation is to always use underrelaxation factors that are as high 
as possible, without resulting in oscillations or divergence.
• If value is too high, the model will be unstable, and may fail to converge
• If value is much too low, it will take longer (more iterations) to converge.
– Default settings are suitable for a wide range of problems, we can reduce the 
values when necessary.

– Appropriate settings are best learned from experience!
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Solution Accuracy
① Remember, a converged solution is not necessarily a correct one!

② If flow features do not seem reasonable:

A. Always inspect and evaluate the solution by using available data,
physical principles and so on.

B. Use the second-order upwind discretization scheme for final results.
C. Ensure that solution is grid-independent

A. Reconsider physical models and boundary conditions
B. Examine mesh quality and possibly re-mesh the problem
C. Reconsider the choice of the boundaries’ location (or the domain):
inadequate choice of domain (especially the outlet boundary) can significantly
impact solution accuracy.
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Mesh Quality and Solution Accuracy

① Numerical errors are associated with calculation of cell gradients and 
cell face interpolations.

② Ways to reduce the numerical errors:
A. Use higher-order discretization schemes (second-order upwind, 

MUSCL)
B. Attempt to align grid with the flow to minimize  the “false 

diffusion”

③ Refine the mesh
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Refine the mesh
① Sufficient mesh density is necessary to resolve salient(重要) features of flow

• Interpolation(插值) errors decrease with decreasing cell size

② Minimize variations in cell size in non-uniform meshes
A. Truncation error is minimized in a uniform mesh
B. FLUENT provides capability to adapt mesh based on cell size

variation

③ Minimize cell skewness and aspect ratio
A. In general, avoid aspect ratios higher than 5:1 (but higher ratios are

allowed in boundary layers)
B. Optimal quad/hex cells have bounded angles of 90 degrees
C. Optimal tri/tet cells are equilateral
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 Grid-Independent Solutions

① It is important to verify that the mesh used was fit-for-purpose.
– Even if the grid metrics(指标) like skewness are showing the mesh is of a
good quality, there may still be too few grid cells to properly resolve the
flow.

② To trust a result, it must be grid-independent. In other words, if the 
mesh is refined further, the solution does not change.

③ Typically we should perform this test once for most of our problems.



174/253

热流科学与工程
教育部重点实验室

Determining Grid Independence

Procedure:
① Obtain new grid:

Adaption(细化或者粗化网格,可把某些计算区域的网格细化以提高计

算精度，也可把某些计算区域的网格粗化以节约计算资源。)
A. A process by which the mesh is selectively refined in areas that are

affected by the adaption criteria specified.
B. If we know where large gradients are expected, we need to have fine

grids in the original mesh for that region, e.g., boundary layers.

② Continue calculation until it converge.
③ Compare results obtained with different grids.
④ Repeat the procedure if necessary
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10. Results and Analysis:  Graphics, Animation and Reports

① Heat flux report:
– It is recommended that we perform a heat balance check so to ensure that 
our solution is truly converged.

② Exporting heat flux data:
– It is possible to export heat flux data on wall zones (including radiation).
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Available Variables for Heat Transfer
Static Temperature Total Temperature

Enthalpy Relative Total Temperature

Rothalpy(滞止焓) Wall Temperature

Wall Temperature (Thin) Total Enthalpy

Total Enthalpy Deviation Entropy

Total Energy Internal Energy

Total Surface Heat Flux Surface Heat Transfer Coef.

Surface Nusselt Number Surface Stanton Number
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Velocity magnitudeVelocity vectors Pressure field

Streamlines Pathlines
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12.4.2. Physical models

Reacting Flow Modelling
A. Eddy dissipation model
B. Non-premixed, premixed and partially premixed combustion models
C. Detailed chemistry models
D. Pollutant formation
E. Surface reactions

Multiphase Flow Modelling
A. Discrete phase model
B. Eulerian model
C. Mixture model
D. Volume-of-Fluid (VOF) model



179/253

热流科学与工程
教育部重点实验室

• Modelling Moving Parts

Multiphase Flows

In many flows, there is more than one fluid present in the domain
A. Different substances (e.g. oil&water, or water&air)
B. Different phases of same substance (water & steam)

A. Single and multiple reference frames
B. Mixing planes
C. Sliding meshes
D. Dynamic meshes
E. Six-degree-of-freedom solver
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• Many flow problems involve domains which exhibit forms of motion.

Modelling Moving Parts

• Two types of motion are possible – translational and rotational.

• There are two modeling approaches for moving domains:
– Moving Reference Frames(运动参考坐标系)
– Moving/Deforming Domains
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12.4.3 User Defined Functions
What is a User Defined Function?
① A UDF is a function (programmed by the user) written in C which can 

be dynamically linked with the FLUENT solver.
• Standard C functions

② Exponential, control blocks, do-loops, file i/o, etc.
• Pre-Defined Macros

③ Allows access to field variable, material property, and cell geometry
data and many utilities
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Why program UDFs?

① Customization of boundary conditions, source terms, reaction 
rates, material properties, etc.

② Customization of physical models
③ User-supplied model equations
④ Adjust functions (once per iteration)
⑤ Execute on demand functions
⑥ Solution initialization

Standard interface cannot be programmed to anticipate all needs:
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User Access to the FLUENT Solver
Δ



184/253

热流科学与工程
教育部重点实验室

12.5 Introduction to ICEM and Meshing with 

ICEM for structural and unstructural grid
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With the continuously growing capabilities of modern computing systems, the
demand for more detailed analysis and assessment of fluid behavior is
growing. However, the flow domain is in most cases defined by complex
geometries, for which it is not always easy to establish a high quality
discretized model.

ICEM, Ansys meshing, Gambit, Hypermesh, Tgrid, Pointwise, Gridpro, ANSA,
turbogrid… ; About 70 software products available.

Which one to choose?

Companies offering commercial mesh generation softwares:

Public domain, downloadable and university codes: more than 100 types. 
(http://www.robertschneiders.de/meshgeneration/software.html#Ansys)

Mesh Generation:
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1. Use the mesh generator which is being used by your friends who are
available to help you out.

2. ICEM is a good software(Hexa), but it is difficult and takes a lot time to
learn.

3. We can also use combination of different meshers. For example: Gambit and
ICEM. Use Gambit for geometry cleaning and tetra volume mesh. This mesh
was saved in .msh format and imported into ICEM. Where with build topology
underlying geometry was reproduced and then prism mesh was extruded from
the tetra mesh near to wall surface.

Rule of thumb:
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ICEM CFD mesh types

ICEM CFD can generate both structured and unstructured
meshes using structured or unstructured algorithms which can
be given as inputs to structured as well as unstructured solvers.

12.5.1 Introduction to ICEM 

Mesh Types

Unstructured Mesh Hybrid Mesh Structured Mesh
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What is a Mesh?
• Mesh

Volume comprised of elements used to discretize a 
domain for numerical solution

•Heat Transfer

•Fluid dynamics

•Other
• Nodes

•Point locations of element corners
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3D-Volume

① Tetra（四面体）

② Pyramid（棱锥）

③ Prism（棱柱）

④ Hexa（六面体）

2D – Surface/Shell

① Quads(四边形)

② Tris（三角形）



190/253

热流科学与工程
教育部重点实验室

GUI and Layout for ICEM CFD

Data Entry
Panel

Model
Tree

Message
Window

Utility
Icons

Function Tabs

Histogram
Window

Utility Menu

Selection Toolbar

Display 
Triad
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File and Directory Structure
• Primary file types:

– Tetin (.tin):  Geometry
• Geometry and material  points
• Part association
• Global and entity mesh sizes
• Created in Ansys ICEM CFD or Direct Cad 

Interface
– Domain file (.uns)

• Unstructured mesh
– Blocking file (.blk)

• Blocking topology 
– Attribute file (.fbc, .atr)

• Boundary conditions, local
parameters & element types

.prj .uns

.tin .blk

.fbc

.par .jrf.rpl
– Parameter file (.par)

• solver parameters & element types
– Journal and replay file(.jrf, .rpl)

• Record of performed operations (echo 
file)
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③ Measure
–Distance
–Angle
–Location

② View
–Fit

•Fit active entities into screen
–Box Zoom
–Standard views

Some Commonly Used Utilities
① Edit > Undo/Redo ④ Surface display

-Wireframe
-Solid
-Transparent
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Function Tabs

Mesh

Blocking

Edit Mesh

Geometry Create/Modify geometry

Set mesh sizes, types and methods
Set options; Auto create Shell, Volume, Prism 
meshes

Initialize a block
Split/modify blocks
Generate structured hexa mesh

Check, Smooth, Refine/ Coarsen, 
Merge, Auto repair, Manual edit, 
Transform, etc.

Output
Set Boundary Conditions and Parameters；
Write mesh for 100+ solvers.
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Primary Function Tabs

Post
Processing

Visualize results: cut plane, 
streams, animation, calculate 
integral and more.

Set force, pressure and 
temperature loads

Set constraints, displacements, 
define contacts, initial velocity, 
rigid walls

Set parameters, attributes, create 
subcases, write out input file, run solverSolve options

Loads

Constraints

Properties Create, read, write out material properties
Apply to geometry/elements
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•During select mode, selection toolbar appears
–Filtering of entities            -Linked to select mode hotkeys

Blocks

Toggle Dynamic 
Mode (F9)

Select allPolygon Only visible

Cancel

Flood fill to Angle

By Part

Entity Filter

Geometry

Mesh

Faceted Geometry 
Segments

All ShellsEntire/Partial toggleCircle

Flood fill to Curve

Set FF angle

Mesh on Geom

From 
Corners

By Subset In between segments

Selection Toolbar
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Workflow

Workflow

Typical ICEM Workflow:

2.Import/Create geometry
3.Build topology/Clean geometry

4. Mesh model (Possibly Hex Blocking)
5. Check/edit mesh

6. Output to Solver
7. Post-process

1.Create/open new project
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The unstructured mesh generation procedure:

1.Create/Import geometry

2.Repair geometry ensuring a closed volume

3.Determine global meshing parameter

4.Specify part mesh setup

5.Specify curves and surface mesh size

6.Compute mesh
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Geometry import
① Directly from CAD package
② 3rd party formats (step, acis, etc…)
③ Via Workbench/Design Modeler

ICEM was designed to mainly import geometry, not create complicated
geometries, although many geometry tools are provided.

• Surface geometry kernel
– Imported solids are converted to surfaces
– Geometry fixing

ICEM CFD provides:
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Geometry Import CAD from just about any source
① Direct CAD Interfaces

– Set up ICEM meshing requirements within CAD 
environment

• Saved within CAD part
• Retained for parametric geometry changes

– Directly write out ICEM formatted geometry (tetin file)
• No 3rd party exchange (clean!)

– ProE, Unigraphics, SolidWorks

② Direct import
–ACIS (.sat)   -CATIA V4  -DWG/DXF
–Catia V4 -IDEAS       -GEMS
–IDEAS (IDI) –Parasolid -STEP/IGES
–Pro/E          -Unigraphics
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12.5.2 Introduction to Surface/Shell Meshing with ICEM

Usages of shell meshing:

① Thin sheet solid modeling (FEA)

② 2D cross sectional analysis(二维) (CFD)

③ Input for volume meshing (FEA/CFD)
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① Mesh method
– Algorithm used to create mesh

Can have different types/methods set on different surfaces

1.General Procedure

② Mesh type
– quad/tri/mix

③ Mesh sizes
a. Small enough to capture physics, important features
b. Large enough to reduce grid size (number of elements)

• Memory limitations
• Faster mesh/solver run

a. Set mesh sizes on parts, surfaces, and/or curves
b. Based on edge length

First need to decide mesh setup parameters
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① For entire model
② Scale factor（全局比例参数）

• Global setting by which many local settings are 
multiplied

• Good for scaling overall mesh
③ Global Element Seed Size（生成网格的全局尺寸）

• Maximum possible element size in model
• Default size if don’t wish set sizes

④ Curvature/Proximity Based Refinement（根据曲率
和邻近区域的网格细化）

Global Mesh Size
2. Global Mesh Setup

• Automatically creates smaller element size to better capture geometry 
• Only for Patch Independent method and tetra octree
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Global Mesh Setup Mesh tab
① To change defaults globally for size, method and type
② For entire model
③ For Shells
④ For Volume
⑤ For Prism
⑥ To periodicity

Parameters relative to scale factor
– Max size
– Height – Max deviation

– Min size limit
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– From Global Mesh Setup tab
– Set surface mesh parameters globally

• Defaults for the selected mesh method
（所选网格方法的默认设置）

3.Global Shell Meshing Parameters

– Method
① Autoblock(自动每个面生成二维 Block后生成网格)

② Patch dependent(根据面的轮廓线来生成网格)

③ Patch independent(网格生成不严格按照轮廓线)

④ Shrinkwrap(忽略大的几何特征)

⑤ Delaunay(三角网格生成算法)
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– Global types and methods can be 
overridden by:

Local settings

• All Tri, Quad with one tri
• Quad dominant, All quad

Type

– Options for different methods

In Surface Mesh Setup
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4. Part Mesh Setup

– Max. size
• Multiplied by global Scale Factor = actual size

– Set mesh parameters on all entities within part



207/253

热流科学与工程
教育部重点实验室

Quad layers grown from curves (e.g. rings around holes) , use these 3 parameters:

– Height: First layer quad height on curves
– Height ratio: growth ratio which determines
the heights of each subsequent layer
– Num layers: Number of rings/inflation layers

Inflation layers: Mesh orthogonal to
surface with faces perpendicular to
boundary layer flow direction (膨胀

边界层)
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• If done in the Part Mesh Setup interface we must set up the Apply inflation 
parameters to curves

Or set on
individual
curves

• For quad layers, the minimum required to be set is height (1 layer) or num 
layers (height = max. size) 3-5
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5. Surface Mesh Setup
① Same parameters as part mesh setup but 

also includes:
– Mesh type
– Mesh method

② Select surfaces first from screen, set 
sizes/parameters and Apply

③ Mesh method/type will override(覆盖) global 
shell mesh settings for selected surface(s)

④ Will override (覆盖) Part Mesh Setup 
settings if set afterward
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• Right mouse, select in Model tree on
Surfaces > Tetra/Hexa Sizes

Display

– Icon appears for each surface
– Gives a visual estimate of prescribed max. size
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6. Curve Mesh Setup

– General
• Same as Surface Mesh Setup
• But also can prescribe(设置) Number of nodes

– Instead of element size
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– Initial spacing from either curve end
– Bunching laws(指定节点分布规律)

– Expansion ratios from either curve end
– Matching of node spacing to adjacent curves

• Also includes node biasing along curves(调节节点疏密)

Select curves first, middle mouse to accept selection, 
then type in parameters/sizes - Apply
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Curve Mesh Setup
– Dynamic Method

– Copy Parameters

– Curve Mesh Setup will override Part Mesh Setup
parameters if set afterward

• Adjust mesh parameters on screen
• Interactively toggle(切换)displayed values near curve
with left (to increase)/right mouse (to decrease) keys

• Copy parameters set on curve to one others
• e.g. parallel curves, downstream
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• Patch Dependent(根据面的轮廓线来生成网格，能够较好地捕捉几何特征,创
建以四边形为主的高质量网格)
– Based on loops of curves surrounding patches
– Best for capturing surface details and creating quad dominant mesh with good quality

Algorithm used to create mesh
7. Mesh Methods

• Patch Independent (网格生成不严格按照轮廓线，生成网格过程中能够忽略

小的几何特征,适用于精度不高的几何模型)
– Robust octree algorithm
– Good for dirty geometry, ignoring small features, gaps, holes

• Autoblock（自动在每个面上生成二维的 Block然后生成网格）

– Based on 2D orthogonal blocks
– Best for mapped meshing, mesh follows contours of geometry
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– Automatic defeaturing(模型简化)
– Quick Cartesian algorithm
– Allows ignoring of larger features, gaps and holes

• Shrinkwrap(一种笛卡尔网格生成

方法,会忽略大的几何特征,适用于复

杂的几何模型快速生成网格)

• Delauney（三角网格生成算法）

– Allows for transition in mesh size
• Coarser towards surface interior

– Tri only
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– Set in Global Mesh Setup > Shell Mesh
Parameters or Surface Mesh Setup (local
upon selected surface entities
• Global defaults overridden(覆盖) by
local settings

8. Mesh Types
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Mesh Types

– All Tri
– Quad with one Tri（面上的网格
单元大部分为四边形,最多允许有一个三角形网格单元；）

• Almost all quad except with one tri per surface
• Single tri allows transition between uneven mesh distribution on loop edges
• Where pure quad will fail

These mesh types will look different with the different mesh methods

– Quad Dominant
• Allows for several transition triangles
• Very useful in surface meshing complicated surfaces where a pure quad mesh may 

have poor quality
– All Quad
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Once sizes, methods and types are set – ready to compute!

9. Compute Mesh

• Select Mesh > Compute Mesh >Surface Mesh Only

– Most of the time can just select Compute at bottom of panel which will create 
shell mesh for entire model (Input = All)

– Overwrite Surface Preset/Default Mesh Type/Method
• To quickly override global and local settings
• Avoid going back to other Mesh Setup menus to change parameters
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① Can mesh All (default – entire model)
② Visible – only visibly displayed surfaces/geometry

③ Part by Part
– Parts meshed separately
– Mesh will be non-conformal between parts 

④ From Screen
– Select entities to mesh from screen

Input
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To automatically create 3D elements to fill volumetric domain

12.5.3 Introduction to Volume Meshing with ICEM

① Generally termed “unstructured”（非结构

网格）

② Full 3D analysis
• Where 2D approximations don’t tell the
full story

③ Internal/External flow simulation

④ Structural solid modeling
⑤ Thermal stress Finite element analysis
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1. Standard procedures
② Start from existing shell mesh

③ Start from both geometry and shell mesh

• Potions of model already meshed
– Inflation layers

• “Prism” sizes

• Octree tetra(八叉树四面体)
– Robust
– Walk over features

• Cartesian（笛卡尔方法）

– Fastest

• Delauney/T-grid
– Quick

• Advancing Front
– Smoother gradients, size transition

（梯度光顺，尺度过渡）

• Hex Core（六面体核心网格）

• Hex Dominant（全六面体）

① Start from just geometry(从已有几何
体开始）
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– Optional
• Recommended for complex geometries（复杂几何体）

• Multiple volumes（多个几何体）

– Geometry -> Create Body– Material Point

2. Define Volumetric Domain(设置体区域)

• Centroid of 2 points
– Select any two locations whose mid-point is within volume
– Preferred（首选方法）

• At specified point
– Define volume region by “point” within volume

Material Point
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• Defines volume region by set of closed 
surfaces（通过设置封闭曲面定义体）

• Must first Build Diagnostic Topology
（必须先建立诊断拓扑）

• Entire model
– Automatically define all volumes

• Selected surfaces
– User selects surfaces that form a closed volume

（用户从封闭体选择面）

By Topology



225/253

热流科学与工程
教育部重点实验室

3. Volume Meshing General Procedure

– Global Mesh Setup > Volume Meshing 
Parameters
– Select Mesh Type
– Select Mesh Method for selected Type
– Set options for specific Methods

① First decide volume mesh parameters
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② Set mesh sizes

– Globally
• As in Shell Meshing

– Locally
• Part/Surface/Curve Mesh Setup
• As in Shell Meshing
• For From geometry only

– Octree（八叉树）

– Cartesian（笛卡尔）
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③ Load/create surface mesh
–As in shell meshing section
–For Delauney, Advancing Front, T-grid, Hex-Dominant

• Either of these types run from geometry will automatically
create surface mesh using global and local Shell Mesh settings
without any user input/editing(以上方法均通过全局和局部网

格设置，从几何开始创建网格，无需用户干预)

• If in doubt, run Shell Mesh first, then from existing mesh(先生成面网格，

再生成体网格)
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④ Define volumetric region
– Typically for octree on complex models(在复杂模型上进行Octree划分)
– Multiple volumes

⑤ Compute Prism (optional)

– As separate process(可作为分开过程)

– Also option to run automatically following
tetra creation(也可随四面体网格生成自动划分)
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⑥ Compute Mesh

– Mesh> Compute Mesh > Volume Mesh
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• Hexa (cartesian ) filling majority volume（六面体网格填充主要区域）

4.Mesh Types
① Tetra/mixed（四面体/混合）

– Most used
– Tetra
– With hex core（带有六面体核心的网格）

Pure tetra

• Tetra (from delauney algorithm) used to fill between surface 
or top of inflation layers and hex core（四面体填充表面（或

棱柱层）和六面体网格核心之间的区域）

• Pyramids to make conformal between tetra tri and hex 
quad faces（四面体和六面体之间采用金字塔形状过渡）
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– From existing quad mesh（从已存在的四边形网

格开始）

② Hexa-Dominant（六面体为主）

– Good quality hex near surface（近表面六面

体的网格质量较好）

– Somewhat poor in interior（内

部网格质量较差）
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– Automatic pure hexa(纯六面体)

③ Cartesian（自动生成的六面体非结构网格）

– Rectilinear mesh(直线网格)
– Staircase or(阶梯梯度)

– Body fitted(体适应)

– Fastest method for creating
volume mesh
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12.5.4. Prism Meshing 

(1) To simulate the boundary layer effects;
(2) Mesh orthogonal to surface with faces
perpendicular to boundary layer flow
direction.

Inflation layers:

The velocity and temperature gradients normal to a wall is typically
much larger than the gradients parallel to the wall. Use inflation
layers to correctly capture the velocity and temperature gradients
near no-slip walls.
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•From existing mesh
-Extrude into tetra/hexa mesh
-Extrude from surface tri mesh, then fill volumes

•Run automatically during Volume Mesh creation

Procedure

2) Select Parts to grow layers from:
•Typically wall boundaries and holes

1) Set Global Prism Parameters

3) Set Local Parameters for each part
•Local overrides global
•Zero or blank will defer to global settings (零或空白将依照全局设置）

4) Run mesher
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Prism -Global Parameters

Growth law
• exponential:         height = h(r)(n-1) [n is layer #]
• linear:                   height = h(1+(n-1)(r-1))
• wb-exponential:   height = h*exp((r-1)(n-1))

Initial height of first layer: h in above eq.
-Auto calculated if not specified

• Based on factor of edge length of base triangle/quad
• Height determined so that top layer volume is slightly

less than that of tetra/hex just above it
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Number of layers: n
Height ratio:  r
Total height: usually left blank

• Or specify only Height ratio and Number of layers for auto 
calculation of initial height

Usually specify 3 of the above 4 parameters

• Compute params(参数组) will calculate the remaining parameter

• Individual surface/curve height/ratio/layers will override these 
global defaults if set
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Growth Law Comparison

The growth rate of wb-exponential is greater than exponential
The growth rate of exponential is greater than linear

Linear Wb-exponentialExponential
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• Setting Prism Parameters on Parts

If Apply inflation 
parameters to 
curves is toggled 
on, they will also 
be set on each 
curve within each 
part 



239/253

热流科学与工程
教育部重点实验室

• Setting Prism Parameters on Volume Parts
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• Setting Prism Parameters on Surfaces

Mesh > 
Surface Mesh Setup 
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• Setting Prism Parameters on Curves

Mesh > Curve Mesh Setup 
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• The Select Parts for Prism Layer button pops up
(弹出)the same menu as the Part Mesh Setup, except 
non-prism related columns aren’t displayed 

Run Prism
• Can run separately
Mesh > Compute Mesh > Prism Mesh

• Input
-Existing Mesh
-From File
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12.5.4 Examples to generate structural grid
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Auto-meshing algorithms for unstructural grid may make it easier but 
the grids they create may lack key qualities.
Reasons for taking the time to create structured grids in CFD 

① High Degree of Quality & Control

② Better Alignment: Better Convergence

③ Less Memory and Time Required

④ The Data Locality Issue

⑤ It Has Available Solution Algorithms

⑥ Definable Normals Unstructured mesh

Structured mesh



245/253

热流科学与工程
教育部重点实验室

The structured mesh generation procedure:
1.Create/Import geometry.

2.Initialize blocking with respect to geometry dimension

3.Generate block structure using the split, merge, O-grid definition.

4.Associate vertices to points, edges to curve and block faces to 
geometry face.

5.Check block structure quality to ensure the block model meets 
specified quality threshold.
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6.Determine edge meshing parameters and using spacing 1 or
spacing 2 for increasing mesh density in specific zone.

7.Using pre-mesh to update mesh.

8.Check the cell quality of the mesh once its generated.

9.Convert structure mesh to substructure mesh by right click on the 
re-compute mesh.

10.Write output files to desired solver like fluent.
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Example 1: 2D Pipe Junction
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Example 2：Flow in a U turn
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R1500
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Example 3: Three pipe junction
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Example 4 Flow in a “Y” tube
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Next Class:

Fundamental:

Prof. Ren Qinlong(任秦龙)

Intermediate:

Prof. Chen Li(陈黎)
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Thanks very much!
谢谢各位!

同舟共济
渡彼岸!
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